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The scanner and the bundled software comply with 
TWAIN for the PC platform. For the scanner and 
scanner software to perform suitably to task, you 
should at least have:

• Intel® Pentium 1.2GHz or better
• At least 512MB RAM (1GB for Windows® 

Vista / 7)
•  Windows® XP / Vista / 7
•  500MB available hard disk space
•  CD-ROM or DVD-ROM drive
•  SVGA color monitor
•  Available USB port

This chapter covers the scanner installation and has 
the following topics:

  System Requirements

   Unpacking the scanner

    Package contents

    The scanner parts

    Unlocking and locking the scanner

    Installing the scanner

    Installing TWAIN

1Setting Up the Scanner System Requirements

Setting Up the Scanner

Chapter One
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Carefully unpack the contents of the scanner          
package.
Inspect the items closely and if you fi nd any item 
damaged or missing, please contact your Service 
Center. Also, save the box and packing material for 
in case you have to ship the scanner later.

Document 
Cover

Scan Window 
Glass

Carriage Lock
LED Power Indicator
LED Ready Indicator

 Power Switch

•  Document Cover
The document cover holds the document in place 
during scanning. It can be raised when scanning 
objects such as books.

•  Scan Window Glass
The scan window glass is where you lay down 
and position documents for scanning. Alignment 
marks and rulers are printed on the borders to 
help you  position documents.

•  Carriage Lock
The carriage lock prevents the scanner’s internal 
mechanism from moving during shipment. Un-
lock the scanner before using and re-lock it when    
shipping the scanner.

•  LED Power Indicator
When you turn on the scanner, the LED power     
indicator fl ashes momentarily and then remains 
lit.

Unpacking the Scanner

The Scanner Parts

Setting Up the Scanner

Chapter One
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•  LED Ready Indicator
When scanning or warming up, the LED ready     
indicator will keep fl ashing. When the scanner is 
available for scanning, the LED ready indicator 
will remain lit.

•  Power Switch
Powers ON/OFF electrical power.

Setting Up the Scanner

Chapter One

Power Cord Receptacle

USB Port

Transparency 
Adaptor Port

•  USB Port
The Universal Serial Bus Port on the rear panel 
are true plug-and-play serial ports for attaching 
your scanner to your computer.

•  Transparency Adapter Port
This port is for connecting an optional transpar-
ency adapter. 

•  Power Cord Receptacle
Connect the scanner Power Cord to the Recep-
tacle. This is used for your scanner’s power      
supply.
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Unlocking the Scanner
In the rear of the scanner is a carriage lock that    
protects the scanning mechanism during shipping. 
To prevent causing damage to the scanner, you 
should unlock the carriage before operating the 
unit. As shown in the illustration, push the carriage 
lock up to release the carriage.

Locking the Scanner
In case you need to ship the scanner once afterin-
stallation, be sure to lock the carriage.
Failing to do so may cause damage to the unit’s 
scanning mechanism. To lock the scanner, fi rst se-
lect Start, Programs, A3 scanner, “Scanner Lock”. 
After successfully running the program, and the 
carriage has stopped moving, you can now lock the 
scanner by pushing the carriage lock up as shown 
in the illustration. 

Setting Up the Scanner

Chapter One

Lock

Unlock

Lock

Unlock
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Installing the Scanner Driver
Please complete the software drivers installation  
before installing the scanner. Do not connect the 
power cord to the scanner at this stage.

1. Insert the Driver Instal-
    lation CD into your disk 

drive.

2. Follow all on screen 
    instructions.

If, after inserting the Driver Installation CD into 
your disk drive, the Driver Installation Welcome 
screen does not appear, do the following:

a. Click on Start and select Run.

b. In the Run dialog box, type drive:\run where 
driver is your CD-ROM drive and click OK.

Setting Up the Scanner

c. Follow all on-screen instructions.

When presented with the option of whether to      
restart Windows after completing the software     
drivers installation, please choose Yes.

Note: Do not use the “add hardware” icon to install 
your scanner. 

Chapter One
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Confi guring the Software
In order to scan with your scanner driver, you must 
first configure the TWAIN-compliant application 
software that came with your scanner or which was 
purchased separately.
The configuration process only has to be done 
once. After the confi guration process is complete, 
the TWAIN driver will control all interactions be-
tween your scanner and the host program. To con-
fi gure the software:
1. Make sure the scanner is still on.
2. Launch Windows.
3. Launch the host application software that came 

with the scanner.
4. Open the host application’s Select Source        
  command (usually under the File menu) and 
  choose Select Source to display the Select  
    Source dialog box.
5. From the list of sources, choose your scanner  

Setting Up the Scanner

as your image source and click Select. You will    
return to the main screen of the host application.  
Software confi guration is now complete.

Network Scan
Enable users to search the installed A3 scanners in 
the network and acquire images from this network 
scanner.
Note: You must install TCP/IP Internet Protocol 
and complete its required installation and setting. 
To use the Network Scan:
1. When using any application program to Select 

Source, choose Scanner-Network.

Chapter One
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Setting Up the Scanner

2. Select Acquire from the File menu (in some      
programs, the Acquire command will appear 
in a submenu under the Import command) and 
start scanning and acquiring the images from the 
host computer through the network.

Note: If you are acquiring the above source          
(Scanner-Network) for the fi rst time, the 

 software will process the search in the 
 network so as to fi nd the host computer that 

has installed this scanner. The dialog box 
representing searching process appears.

You can also call out this dialog box by select-
ing Start, Programs, Scanner. When you run Host      
Scanner for Network Command, Dialog 1 ap-
pears fi rst ,and then Dialog 2.

(Dialog Box 1)

Computers that have installed this scanner appear 
in the dialog box 2. You will be asked to select one 
of them to access its installed scanner.

(Dialog Box 2)

Chapter One
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3. Connect the other end of the scanner’s USB 
cable to the scanner’s USB port.

Upon connecting the USB port, the Windows 
Operating system would automatically detect your 
scanner and update your system confi guration.

Setting Up the Scanner

Chapter One

Installing Hardware
Refer to the following illustration and steps to      
connect your scanner:

1. Connect the power adapter to the scanner and 
plug it into an appropriate power outlet.

2. With the power to your computer on, connect the 
scanner’s USB cable to the USB port of your   
computer.
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Position the Document
For the best possible image scans, it is important 
that you position your documents correctly and 
carefully. For this tutorial, use a paper-based docu-
ment such as a color photograph. Procedures for 
document  positioning are as follows: 

1. Lift the scanner document cover.
2. Place the document face down on the glass and 

in the upper center corner.
3. Slowly lower the scanner document cover,           
    making sure the document remains in position.

Power Up the Scanner
1. First, power up the scanner by pushing the 
 power button.

The LED power indicator on the front panel 
of the scanner lights up and fl ashes for about a 
minute and then remains lit, signifying that the 
scanner is ready.

2. Power up the computer and wait until the          
    computer fi nishes booting.

Scanning Tutorial
Scanning Tutorial

2

Chapter Two
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Using the Scanner Panel 
The Scanner Panel is a useful tool for users to 
scan in a quick and easy way. With its user-friendly     
interface, you can perform scanning within seconds 
and create your personal style with the scanned   
images by using the bundled softwares, including 
the following:
Batch Fax, Multi-Page Scan, Multi-Page OCR, Scan to 
Save, Image Enhancement, JPEG 2000, Smart Image 
Merge, Smart Photo Refresh, JPEG 2000 Viewer, Cali-
bration Toolkit and Network Scan. 

Following are the basic functions of the panel:

Scanning Methods 
There are two separate methods to scan an image. 
The Scanner Panel is ideal for quick and simple 
scans, while the TWAIN Driver offers more con-
trol over the output.

Status and Progress Bar Area 
Shows the current state of operation on the Panel. 

Scan 
Click to start scanning.
Note: Status and Progress Bar Area shows warning   au-
tomatically when nothing is put on the scanner glass.

Copy 
Click to call out a Panel and start copying. 
Note: you can perform basic functions of copy machines 
by changing the settings on the Setting Panel.

Fax 
Click to fi rst scan the document. Upon completion, 
a panel appears on screen to fax.
Note: Advanced fax tools are provided  for fi nal retouch-
ing. (e.g. move, rotate, add lines or texts and more.) 

Email 

Clicks to email the document with the image you 
put on your scanner window glass.

Scanning Tutorial

Chapter Two
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Status and 
Progress 
Bar Area 

The Scanner Panel

Settings

Help

Copy

Exit

Fax
Email

OCRPersonal 
Style

Link

Scan

Scanning Tutorial

Chapter Two
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OCR (Optical Character Recognition)
Clicks to recognize the document with the images/
characters you put on your scanner window glass.
Exit 
To exit (or close) the Panel, simply click on the      
Exit icon.
Help
Help allows you to get information about the       
various topics and procedures enabling you to 
use and have a clearer understanding about your        
scanner and its functions.
Personal Style
Allows you to make changes to your systems.
Link
To use the additional programs bundled with your 
scanner, click on this button to call out the following 
items:
Bundled Software and Bonus features -
Additional programs bundled with your scanner to 
enhance your image editing process.

Scanning Tutorial

Setting dialog box

For detailed information of how to use these         
functions, please click the Help button on the panel.

Settings
Clicks to call out Settings dialog box and do your 
favored settings.

Chapter Two
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Acquire the Scanner 
TWAIN Driver 
The TWAIN driver is the scanning module pro-
vided with your scanner. It is easily accessed from 
within the bundled scanner software or from within 
any TWAIN-compliant program. Before you start 
with the steps below, be sure you have installed 
and confi gured the bundled scanner software.Refer 
to Chapter one for details.

1. Launch Windows.
2. Run the host TWAIN-compliant software (e.g. 

Photoshop)
3. Call up the TWAIN Data Source by selecting         
    Acquire from the File menu. (In some programs, 
    the Acquire command will appear in a submenu    
  under the Import command.) The TWAIN       
   dialog box will appear in a submenu under the  
    Import command.

The TWAIN dialog box contains control settings, 
which you must set prior to scanning a document. 
The basic steps to scan a document are:
1. Prescan the document.
2. Set the desired image area to be scanned.
3. Select the scan source.
4. Select the desired scan mode.
5. Select the desired resolution.
6. Click on the Scan button.

Scanning Tutorial

Chapter Two
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Folders
Conta in d i f ferent 
control settings

The Dialog Box
The TWAIN dialog box is divided into two sections: the left section where most of the control settings are 
located, and the right section, which is the Preview Window.

Preview Window
Used for viewing the pr-
escan image and select-
ing the fi nal scan area

Scanning Tutorial

Chapter Two
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Resolution
Sets the resolution in dots per inch (dpi). 

Output Scaling
Changes the dimensions of the fi nal output.

Scan Source
Sets the media type of the docu-
ment to be scanned.

Scan Mode
Determines how the scanner will 
read the image and refers to how 
the image will be reproduced after 
it is scanned.

Photo Refresh
Photo Refresh allows you to  automatically 
lighten and sharpen the scanned image 
by clicking on its icon. This function is ap-
plicable when you are scanning images in 
Color 24bit.

Descreen
Sets the media type of the document to be 
scanned to reduce image noise.

Image Size
Displays the amount of computer space 
needed to display or save the selected 
image area.

Scanning Tutorial

Scan Size
Refers to the size of the image or 
document that you are about to 
scan.
JPEG2000 Scan
The latest image compression stan-
dard that usually provides smaller fi le 
size and higher    image quality than 
the original JPEG.

Width and Height
Show the dimensions of the image 
area inside the Crop Frame.

Color Matching Control
Color Matching allows the scanner to more 
accurately reflect the actual colors of the 
original image. 

The Main Folder

Chapter Two
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Scanning Tutorial

Thumbnails
Are used to see the effects of any 
changes in the control settings.

  

 The Enhancement Folder: Brightness/Contrast Control

Brightness Control
Allows you to adjust the overall amount 
of light in the image through a range of 
values (–127 ~0~+127).

Channel Selector Control
Allows you to select the   channel 
layers (red, green and blue) that 
make up a color image. You can 
choose to change the channels 
individually or choose master to 
change all channels equally and 
simultaneously. 

Contrast Control
The Contrast Control allows you to ad-
just the overall amount of black areas 
or white areas in the image through a 
range of values (–127~0~+127). 

Brightness/Contrast Control

Preview Button 
This button allows you to see the ef-
fect of any changes made to the image 
prior to scanning. Any changes will ap-
pear in the preview window. 

Chapter Two
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Level Control
Use the level slider to adjust an image’
s contrast and brightness. 

Histogram
Shows the distribution of the bright-
ness levels in the image.

Eyedropper tools 
Eyedroppers are used to identify an 
image’s highlights and shadows. 

Thumbnails
Are used to see the effects of any 
changes in the control settings.

The Enhancement Folder: Level Control 

Channel Selector Control
Allows you to select the channel 
layers (red, green and blue) that 
make up a color image. You can 
choose to change the channels 
individually or choose master to 
change all channels equally and 
simultaneously. 

Level Control

Preview Button 
This button allows you to see the 
effect of any changes made to the 
image prior to scanning. Any changes 
will appear in the preview window. 

Chapter Two

Scanning Tutorial
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Curve Control 
Applying a curve to an image en-
hances favored brightness ranges at 
the cost of others. 
Add Anchor 
To make a curve, simply place an   
anchor on the diagonal line and 
adjust its position. Add more anchors 
if you have to make a more complex 
curve. 

Remove Anchor 
You can also remove anchors. 

Thumbnails
Are used to see the effects of any 
changes in the control settings.

  

The Enhancement Folder: Curve Control 

Channel Selector Control
Allows you to select the channel 
layers (red, green and blue) that make 
up a color    image. You can choose 
to change the channels individually or 
choose master to change all channels 
equally and simultaneously. 

Curve Control

Preview Button 
This button allows you to see the 
effect of any changes made to the 
image prior to scanning. Any changes 
will appear in the preview window. 

Chapter Two

Scanning Tutorial
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Thumbnails
Are used to see the effects of any 
changes in the control settings.

  

The Enhancement Folder: Hue/Saturation Control

Hue/Saturation Control

Preview Button 
This button allows you to see the ef-
fect of any changes made to the im-
age prior to scanning. Any changes 
will appear in the preview window. 

Saturation Slider 
Lets you adjust an image’s color purity. 

Hue Slider 
is composed of two color bars. The 
upper one is static and the lower one 
movable. Slide the  latter, and you will 
see the image shift its overall coloring. 

Chapter Two

Scanning Tutorial
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The Filters Folder

None
No fi lter is applied.

Invert
Reverses an image to its negative 
or compliment.
Flip
Creates a mirror image of the 
original.

Blur
Smooths or softens the  image.

Emboss
Makes the elements in the 
image appear raised or sunken.

Sharpen 
Enhances the detail in the  image.

Thumbnails
Are used to see the effects of 
the selected fi lter.

Unsharp Mask
Emphasizes shape edges and 
color boundaries.

Scanning Tutorial

Filter Control Buttons 
Use these buttons to add /sub-
tract a degree of the Blur or 
Sharpen fi lter. 

The Filters Tab allows you to   
adjust the individual effects of 
the scanned image by applying       
various fi lters to the image, prior 
to scanning. 

Chapter Two
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Batch Scan Button
Allows creation of up to 30 scan regions 
(or Crop Frames) for  multiple scanning.

Crop Frame
Outlines the scan area or region that will 
be included in the fi nal scan.

The Preview Window

Preview Button
Allows you to see the effect of any chang-
es made to the image prior to scanning. 

Zoom Tool Button
Allows you to enlarge/shrink an 
area of the image in the preview window 

Scanning Tutorial

Cropping Tool 
Selects the area in the Preview Window 
that will be used as the fi nal scan. 

Language Setting 
Allows you to select the desired 
language that the dialog box will be 
displayed in. 
Help Button
Provides On-line Help.
Exit Button
Click to exit (or close) the TWAIN or 
Batch Scan Dialog boxes.

Scan Button
processes the pre-scanned image, and 
displays it in the host software (where 
you opened up the TWAIN dialog box). 

Chapter Two
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Scanning Tutorial

Previous Button
Returns the most recent selection to its previous 
setting. (Reloads the last saved image settings.)

Reset Button
Returns settings to their default values.

Load Button
Loads previously saved image settings.

Save Button
Saves the current image settings.

Info Button
Lists information about the current settings being 
used. 

Chapter Two

Prescan the Image
A Preview is a quick low-
resolution scan of the entire 
original image. From this 
low-resolution scan you can get a clearer idea of 
the image area you want to include when you click 
Scan. To Preview, the steps are:

1. Place the document face down on the scan       
    window glass.
2.  Click the Preview button in the dialog box. 
 After the scanner has scanned the document, the 

scanned image will appear in the Preview 
 Window. From the Preview image, you can now 

set the exact image area you wish to include in 
your fi nal scan.
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2. Select the scan source. 
Since we are going to scan a color photograph, 
choose Refl ective.
Refl ective: 
when scanning paper-based documents such as   
photographs or text (magazines, books, or images).
Negative/Positive: 
when scanning positive film or transparencies, 
or Negative as a source for scanning negative 
fi lm.(usually works with transparency adapter)

3. Select the desired scan mode. 
The Scan Mode determines how the scanner will 
read the image.
•  48-Bit Color captures images in 281 trillion colors
•  24-Bit Color captures images in 16.7 million 

colors
•  CMYK captures images for output to a color 

printer
•  256 Color captures images in its optimum palette
•  256Gray captures images in 256 grayscale

Scanning Tutorial

Chapter Two

Set Up the Scan Parameters
1. Set the desired image area to be scanned. 

Use the Crop Frame in the Preview Window to     
outline the image area you wish to scan. Click one 
of the sides or corners of the Crop Frame and drag 
it out or in to the desired 
length and width. 
To move the entire Crop 
Frame, position the mouse 
cursor inside it and drag 
with the left mouse button.

Only the area inside the Crop Frame will be in-
cluded in the resulting scanned image when you 
click Scan. The size information at the bottom of 
the dialog box is automatically updated when the 
Crop Frame is resized.

Crop frame
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Scanning Tutorial

Chapter Two

• Gray (16 bit) captures 16 bits of grayscale image 
information for every pixel in the screen image

• Text/Line Art is used for text documents or black-
  and-white images

4. Select the desired resolution. 
Resolution is a measure of how much image detail 
information the scanner is to capture in a scan. A 
higher resolution results to a sharper image but    
requires more disk space for file saving. For this  
session, set the resolution to 300 dpi.

Execute the Scan Com-
mand
When you are fi nished with 
the control settings, click on 
the Scan button. The scanner begins to scan the 
document and a message box appears on the screen 
displaying the progress of the scan.

When the scan is fi nished, the image will be dis-
played in the main screen of the host software.



A3 Scanner User Manual (PC)  

25 

Using Batch Scan 
Batch scanning is an easy way to multi-scan any 
part of your document using different scan modes 
and resolutions. In batch scanning, you can specify 
up to a maximum of 30 scan regions, or you can 
scan a single region several times using different 
combinations of scan modes and resolutions.

To activate batch scanning, click on the 
Batch Scan button. This will bring up the 
Batch Scan dialog box.

The Batch Scan Dialog Box
The Batch Scan dialog box contains several controls 
that make batch scanning simple and easy to use. It 
will also display the number of batch jobs that you 
make when you create the scan regions.

Scanning Tutorial

Chapter Two
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• New Batch Button
  Click on this button to create a new 
  scan region on the image in the       
   Preview Window.

• Duplicate Batch Button 
 Click on this button to duplicate a 
 batch job. You can then specify        
 different control settings for this 
  particular batch job.

•  Trash Batch Button
 Click on this button to delete the      
  selected or highlighted batch job.

• Cancel Batch Button
  Click on this button to cancel batch 
  scan and exit the Batch Scan dialog 
  box.

Chapter Two

Scanning Tutorial
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Calibrator
Contents and Requirements
Contents Checklist:
Before proceeding, please insure that all of the       
contents from the list below have been included in 
your package.

1. A3 Scanner User Manual
2. IT8 Target Image Color Card

If anything from the list above is missing or dam-
aged, please contact customer service to have it 
replaced. 

System Requirements:
Pentium III Processor or higher 
CD-ROM Drive
Windows /XP/Vista/7
24-bit Video Card (or higher)
At least 256MB RAM
Minimum 150 MB available hard drive space

Introduction
Using the Calibrator

The Calibrator is a color calibrating program        
provided with your scanner. It allows you to ad-
just the color of the scanned images so that the           
appearance of the image closely matches the colors 
of your original  document.

All of the Calibrator’s functions are contained in 
easy to use graphical interfaces based on the tradi-
tional Windows format. Calibrating the scanner (or        
scanner plus transparency adapter) is a simple task 
that takes only minutes to complete.

About the Target Image

The target image included with this package is to 
be used to create a scanner profi le. The target 
image is very important and must be handled with 
care, or the calibration of your scanner may be ad-
versely affected. 

 Calibrator

Chapter Three

3
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We provide you the target image that can be used 
to calibrate your scanner, the Reflective IT8. It 
allows color matching for photographs and docu-
ments and is used in conjunction with your scanner.

Target Image Handling:

  Do not touch the image with your fi ngers. Han-
dle it by the edges.

  Keep the image away from light when not in use.
This includes sunlight, interior light and light 
from the scanner lamp. Long exposure to light 
will fade the colors and affect accurate calibra-
tion.

 Return the calibration image to its protective 
sleeve  immediately after use.

  Store the calibration image by placing it face-
  down, away from light, in a cool, dry place. 
   A good place to store it (both for protection and 
   ease of memory) is inside the scanner box itself.

Calibrating and Applying 
Calibrating the Scanner
Once you have successfully installed the calibra-
tion software, you are ready to calibrate your scan-
ner and create a scanner profi le.

To Create a Scanner Profi le:
In Advance: 
To ensure the quality of calibration, please do not 
open the document cover during calibrating. 

1.  Make sure that your scanner is properly 
 connected and powered on.
2. Turn on the PC and launch Windows.

3. Place the appropriate target image face down in 
the top center portion of the scanner glass.  Make 
sure that the target image is correctly aligned on 
the scanner glass with the IT8 indicators and TA 
indicators.

Chapter Three

 Calibrator
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5. Click on the Calibrate button. The Calibration 
Wizard dialog box will be displayed. Click Next.

6. Click the Scan button to start scanning. 

Chapter Three

 Calibrator

IT8 Card

Note: It is very important that you use the proper 
Target Image Color Card.

4. Access the Calibrator Wizard dialog box, which 
can be done in two ways:
I)  Selecting Calibrator from the Programs 

Group under the Start menu.
II) Selecting the Calibrator icon from the 
 Bonus Features menu on the Scanner Panel.
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 Calibrator

Chapter Three

7.  After the scanning is done, a Dialog box 
 appears, asking you to start analyzing the 

scanned picture (i.e. IT8 card).

Note: This dialog box shows whether you’ve 
put the card in the right position. If not, go back,          
reposition the card and scan again. 

8.  A scanner profi le appears and shows the result of 
calibration. You can choose whether to Finish, 
Retry or Abort. 
     

The image will be scanned and a profi le of the       
calibration information will be saved to your 
hard disk. This profi le will be used by the com-
puter to automatically match the colors between 
scanned images and the monitor.

Note:  After you have successfully created a 
scanned profi le, you can match the colors 
of your scanned images with this profi le by 
checking the “Color Match” box on the 
scanner TWAIN interface (located in the 
Main Folder.)
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 Scanner Type:  Color CCD Flatbed

Light Source:  Cold Cathode lamp

Color Mode:   true 48-bit/pixel 

Gray Mode:    true 16-bit/pixel

 Text/Line Art: 1-bit/pixel (2 levels)

Resolution
Optical:       1800 dpi (H) x 3600 dpi (V)

Software 
Enhanced:   19200 dpi x 19200 dpi 

Scan Area:   11.7” x 17” (297 mm x 431.8 mm)

Interface: USB 2.0

Dimensions: 27.0” (L) x 17.3” (W) x 6.4” (H)

Power 
Consumption: 36 W

Weight:  15.5 kg (34.21bs)

Support OS: Windows XP/Vista/7 

Option 

TA/scan area: 11.7” x 17” (297 mm x 431.8 mm)

 Appendix
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 Appendix

B

Appendix B

Ensure that your flatbed scanner operates at         
optimum performance by observing the following:

•  Cover the scanner when it’s not in use to avoid   
  dust contamination

•  Avoid environments where the scanner would be    
  exposed to direct sunlight (or any other source of 
  excessive heat) for long periods of time

• Protect the scanner from potential liquid spills 
such as soda, coffee, tea, etc.

• Operate the scanner on a level, well-grounded 
work surface, free of excessive vibration

• Be careful to avoid scratching the glass when        
 placing multi-page documents (bound by sharp 
  staples or paper clips) on the scan window glass. 
  Scratches on the glass will show up as unwanted 
   marks in scanned images.

• Don’t open the scanner case because there is     
 danger of electrical shock and there are no          
 customer-serviceable parts inside. For servicing 
  needs, call your scanner dealer for assistance.

Appendix B: Maintenance
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 Appendix

Appendix B

Cleaning Procedures

1. Power off the scanner and disconnect the power     
    cord.

2. Gently wipe the scan window glass with a soft 
    lint-free cloth and mild liquid detergent to remove   
   fi ngerprints, smudges, or loose particles. Do not    
   use a spray detergent as this may get inside the 
    case and damage the unit’s internal components.

3. Wipe off the detergent with a soft cloth damp 
with water.

4. Finally, dry the surface by wiping it with a clean 
   soft cloth.
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Determining Error Messages
When the scanner is turned on, it will automati-
cally perform a series of self-diagnostic tests. The 
LED power indicator located on the scanner’s front 
panel should tell you if there is something wrong 
with the unit. Upon power up, the LED ready indi-
cator lights up and fl ashes for about a minute and 
then remains lit. The scanner lamp will also be on 
and will remain on until you power off the scanner.

LED Ready Indicator Messages
1. If the LED ready indicator light continues to 
fl ash beyond one minute, call Technical Support.

2. If the LED ready indicator remains lit but the   
    scanner lamp is dim, call Technical Support.

Other Troubleshooting
1. Check to make sure all cable connections are   
    correct:
•  The USB cable is fi rmly plugged into the 
 scanner and the computer.
• The power cord is fi rmly connected to the scan-

ner, plugged into an appropriate power outlet, 
and the power switch is turned on.

Appendix C: Troubleshooting
 Appendix

C
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